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ABSTRACT 

This disseliation describes the development of web site, to make an 
effective presence of the information of F G Boys High School Pano 
Akil Cantt on the Internet. The idea of developing the Webster for F G 
Boys High School Pano Akil Cantt was conceived to promote the 
education through the modem Media of the world Internet. The 
projectunder taken is a singular effOli to store infonnation pertaining to 
the Educational system of Federal Government Educational Institutions 
(Cantt/Garrisons) institutions particularly F G Boys High School Pano 
Akil Cantt in an electronic form and publishing it on the internet, the 
outgoing phenomenon in today's world of information technology. On 
the other hand web site also features of F GEl (C/G) educational 
organization 's efforts in serving the nation to wards education 
throughout the country through its different educational institutions. F 
G Boys High School Pano Akil Cantt is one of them. This web site also 
provides information especially about the F G Boys High School Pano 
Akil Cantt on the Internet to all its users. 
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PREFACE 

The Internet is not just for computer gear-head. It has much good stuff 
that it can be an entertaining adventure even if some one pat1icularly 
don ' t like computer. It represents a fundamental social change of 
immense proportion i.e. changing the world in to a global village. This 
disse11ation discusses the development process of the website of the F 
G Boys High School Pano Akil Cantt. It gives insight to the latest 
growing phenomenon the Internet, tools and techniques used for 
Webster design and different phases of Webster development. 
The proposed system is organized into chapters as follows. 

CHAPTER 1 
It gives an introduction of F G Boys High School Pano Akil Cantt, the 

objectives of the institution, project overview and objectives. 
CHAPTER 2 
It discusses the existing information system of the institution, its 
drawbacks and introduces the proposed system and its benefits. 
CHAPTER 3 
It explains the scenario to complete the project, and list prerequisites 
and tells solution on the place or referred. 
CHAPTER 4 
It introduces and explains the Internet and World Wide Web. 

CHAPTER 5 
It lights upon hypertext Markup language (HTML). 
CHAPTER 6 
It is written to guide the users to under stand the organization of the 
Webster so that future enhancement can be easily accommodated. 
CHAPTER 7 ' 
It describes the testing and implementation phases of the Webster. 
APPENDIX A 
Contains screen of web site. 

APPENDIX B 
Contains the graphics file Formats 
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CHAPTER 1 INTRODUCTION 

1.1 The organization 

The organization FG Boys High School Cantt Pano Akil Cantt is 
an educational institution. It is a unit · of Federal Government 
Educational Institutions (C/G) Directorate Rawalpindi. This 
organization is an attached department of ministry of defense which is 
striving hard to promote the education in the country through its 
different educational . institutions in the cantts and garrisons areas . The 
F G Boys High School Pano Akil Cantt is one of them which is situated 
in the newly cantonment about 12 kilometers from Pano Akil city 
which is the Tehsil Headquarter of Sukkur Distt in the province of 
Sind. It is linked by main railway track and national highway with the 
COl}ntry. The F G Boys High School is one of the educational institution 
which was a established in this cantt in 1988.It started working during 
patiial settlements of the units, to provide the educational facility to the 
children of the troops as well as to the children oflocal community. 

l.l.1 CONSTITUTION OF THE ORGANIZATION 

Learning . is a divinely ordained avocation. Learning is binding duty 
upon every Muslim men and women. Where as teaching is a prophetic 
job by its nature .It is widely accepted fact that in the community of the 
nations only the supremacy has got those nations who have increased 
the ratio of literacy and equipped them with the knowledge in every 
field of science and technology. So for us as a nation it is very vital to 
us \1lcrease 
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the lit era c~1 to r(li se our heads hi gh in the cOllll1lunity orth e Iwti ons \\illl 
mltional pride. which is onl y possible to enrich the youl h or the cOll ntr~ ' 

with educ(ltion . 
As F G Hoys High Sc hool Pano Ak il C(lntt is an ed ucat ional 

institution, it is thc MATTO of thi s inst ituti on to provide not only the 
formal education but also the ed ucation to create nation builder people 
(students) with sy mboli c, dynamic. and multidimensional, well 
behaved and elevated with hi gh moral persons . Where as in the 
institution students are en li ghten with the knowledge that they fell well 
to do socia l individuals in the society . 

1.1.2. OBJECTIVES OF THE ORGANIZATION 

The main objective of the institution is to frame and promulgate the 
constitution of the organization to regulate the administration and 
management to promote the purposeful and reliable education better for 
the future of the nation. 

(a) To set educational envirorlment and academic atmosphere in order to 
provide means of encouraging the students fOl: better learning process 
to achieve good results in all aspects curricular, co cUlTicular and 
extraculTi cular activities . 

(b) To promote better under standing and to give the ri ght direction to 
the up grO\vin g and hidden talent of the students. 

(c) To provide each and every possible facility to enhance the co 
curri cul ar and extraculTi cular activiti es . 

(d) To alTange games and sp011s computati ons at school level for 

(e) 

(f) 

healthy growth and hand some physique of the students. 
To prepare the students for inter houses, inter school, region leve l 

and country level contests and compi lations. in every fie ld of 
curricul ar, co cUITi cul ar and extracurri cu lar activities. 

To provide recreation and to create Hi storical , Cultural, Socia l 
awareli ess among the students Recreation al and Ed ucational tours to 

. Hi storica l and cultural places and study trips to industrial sight s are 
arranged. 
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. (g) Any other object. which is considered suit :lbk for bett erm ent of 
stude nt ' s learnin g proccss and for good reputati l)1l of the instituti oll . 
may adopt in conformity with the rul es and reguLltions of the regional 
office alld Federal Directorate Rawa lpindi . 

1.2 Proj ect Overview 

The proj ect title is "The Development of Webster of F G Boys High 
School Pano Akil Cantt" covers the major areas. 

• Introduction of the institution . 
• Information about the institution . 
• Sites and sounds of the institution . 

The main aim of this proj ect was to publish information in the 
electronic form on the Internet to make it avail able for those users who 
want to get information admi ssion policies and educational system of 
the institution. The Webster also provides information about the 
institution, so that the constitution and cause of the institution can be 
promul gate. 

1.3 Objectives of the proj ect 

The objecti ves of the project are as follows. 
• To provide information in electronic way about the institution . 
• To open the educati onal system on the Internet th ro ugh Webster. 
• To make it easier for the institution to prov ide maximum required 

information . 
• To show the genera l public how the educati onal system is run and 

handled in the institution to create the well bchaved, civili zed, 
energeti c, dynami c, and nation bui Ider " YO UTI I". 

• To pn.:sent it as a model for genera l view of the illformation system 
orthe institution . 

• . To prolll ote the spirit of patri oti sm for nati onal tlnit y and inteb'Tity. 
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• . To broaden the outlook of the students YOUTH and chasten it with 
the thrust ofknowledu.e. 

'-

• To help the parents and guidin g the students abo ut academi c and 
related activities taking place in the institution . 

• To provide earl y information about Registration , Admission , 
Deposit of Fees / Funds, Exam schedul e, Date sheet and Results. 

• To make it a tool for easy access for providing the information to 
the Regional Office Karachi Cantt and G HQ Rawalpindi by llsi ng 
E. mail facility . 

• To help the institution to gather the suggestion . 

I ~ 
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CHAPTER 2 

2.1 EXISTING AND PROPOSED SYSTEM 

The information system of the School is manual. In order to under 
stand the ex isting system, many meetin gs with the school management 
have been arranged. 

All the management activities do take place one-person control s 
the management infrastructure of the school only, who has to take care 
of many parallel issues at the same time. The processing of different 
activities of the institution is determined as follows. 

2.1.1 INFORMATION SYSTEM 

A ny body that wants to get infor·mation about the institution makes 
a visit to the School Office 
Where a (Chowkidar / Watchman) orally provides information needed, 
if he knows, or he / she 
Has to contact the office. 

The information about the institution can only be known by anyone ' s 
own general knowledge 
Or by searching out the brochures being provided by the 
admini strat ion . 

2. 1.2 Registration Procedure 

The office on the req uest provides registration forms. Anybody \-\l ho 
wa nts to get admi ssion 
Has to co ll ect a fo rm from the office of F G Boys High School PNL 
Cantt throu gh direct req uest or indirect req uest. I-Ie/She gets 
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an application form , fills it out , pay registration fee and submit s it to the 
admission committee for furth er process ing or admission . 

2. 1.3 Adtnission test 

As academic year in our country begins from first of April , it is adopted 
I in F G Boys High School Pano Akil Cantt. Registration for new 

admission is made froni I st April to 5th of April. The date for admission 
(entry test) is fixed from 6th to 8th of April. The registered candidates 
are issued admission slip to appear for the test . A comprehensive test is 
organized out of main subjects. 
For class Vl to Vl I] . . 
Subjects: Maths, English, Urdu, and G. Science. 
For class 1 X to X 
Maths, Physics, Chemistry, and Bioloh'Y-
The maximum time limit for test is fixed up to three hours, from 9am to 
12am. 

2.1A ANNOUNCEMENT OF RESULT 

Senior teachers under the super vision of admission com,mittee 
complete with assessment and marking of test in three days . List of 
successful candidates is announced for the admission. 

2.1.5 ADMISSION. 

Admission forms to the qualifying candidates are issued for the 
admission in desired class. Forms are filled out and submitted to the 
admission committee along with required documents, after ' properl y 
checking properly and verifyin g the certificates and docum ents by the 
members of the admission committee under the supervision of the Head 
of the institution the final approval is made with instructions to follow . 



2.2. DRAWBAC KS OF TH E EXISTING SYSTEM 

Drawbacks of the ex istin u svstem are uiven bell ow. 
~ J '-

• The exi st in g system for in form ation is ll1uch slower than any computer 
based system. 

• The request in formation system in many cases can ' t reach to the 
requesting person at proper tim e. 

• There are many mail s and there is onl y one person to handle all the flow 
of these mail s. That is why institution can' t manage information system 
with ease. 

• There is no proper procedure to provide the Registration, Admission 
form s, Result cards and 

2.3 Proposed System 

The proposed system will comprise of a developed web site running on 
to a computer by the software and managed by a webmaster. 
The proposed system will introduce the three new system elements 
namely computer (Hardware & software) and a Webmaster (I n fact four 
in technical sense with context of Software Engineering Because it 
treats the software as a separate system element of). 

The proposed system will require tlu'ee major steps. 

• Developin g Web site 
• Implementation on the Web si te on the Internet (publlshing) 

Maintenance of the Web site 

The last step is to be performed conti nuously throughout the li fe time of 
the new proposed system for the useful functi onality of the proposed 
system. 
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2.4 Benefits of the Proposed Svstenl 

• The proposed system will be Illuch f<l ster th an the e:\i stin g system 
• The requested in fo rm ati on will be send by E- Jl1 <l il and through a quick 

response one can get information quickl y. 
• The Organization can manage information system with ease by E-mail 

facility , no matter the number of mail s. 
• Registration forms will be provided to applicant in short time. 
• The Web site provides the fac ility to the cli ents to feedback the 

institution by E-mail through feedback form. 

IX 
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. CHAPTER 3 

3.1 Understanding the Role of Web Designer 
The Web sit e deve lopm ent is not an easy job. It requires the mind 
creativity at most throu ghout it s des ign and deve lopment phases. 
Unlike the development any computer ,based system, thi s in vol ves the 
human element in a very deep sense. World Wide Web seems to be 
creating a broad definiti on of culture that forces us to recogni ze that 
science and arts are the para ll e l aspects of the same basic creati ve 
impulse rather than unre lated pursuits. Web site development is an art 
more than a science. Art follows no specific rules but it has a theme i.e. 
to serve the humanity, it is true for Web site development. It follows no 
specific rules but it has a theme i.e . to serve the humanity by providin g 
the 21 SI century ' s most valuable thin g "The Information" in an 
appealing way. 
Web designers are challenged to be many things, including computer 
scientists, communication specialists, graphics 311ists, and advertisin g 
authoriti es. Precious little guidance exists to help the Web des igner. So 
he often makes up hi own rules to navigate ·the new circumstanc~s 

existing on the Web . The most impOl1ant of which is to navigate the 
current trend on the Internet to determine the design issues of the Web 
site. 

The rol e of Web designer can be best explained by thinking the 
designer as a physician that's simple ! To be a great physic ian, one must 
understand not only the parts of body, but the way those p31is work 
together in order to functi on smoothl y. 
As a designer, it is important to not onl y understand the parts-HTML 
Computer prof,rrammin g but a lso the way those pmi s integrates w ith the 
whole. And , in thi s case, th at w hole invo lves techn ology of I nternet, art 
of designin g, and analys is power to understand the interac ti on of the 
Web site w ith the hum an 

element at the other end of the e lectroni c data stream (Web). 
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Keepin g in view the above \Veb sit e or F_ G_ Boys Hi gh Sc hoo l Pano 
Akil Cantt is expl ained as un de r. 

3.2 Understandin g the Inten1et and World Wide Web 

Web desi gner should know about the Internet and World Wide Web, 
the technology, its fun ctioning, its hi story, its impact on the humanity, 
its global acceptance and have to anal yze the current trend. Chapter 4 is . 
dedi cated -for thi s purpose . 

3.3 Deten11ining the Design Issues of the Web site . 

After understanding the Internet and W orld Wide W eb, there is a need 
to determine the desi gn issues, and then deve lop a desi !:,111 strategy for 
developing the Web site . Thi s task can be accomplished by surfing the 
Web and making visits to the organization and asking for their needs. 
And then splitting out the needs, which can be ful fill ed by Web site. 
These needs are in fact the design issues of the Web site . 
The design issues of the Web site of F _G_BOYS HIGH SCHOOL 
PANO AQU1L CANTT is as follows 

.:. Web site should contain the general information about the school 

.:. Web site should contain the information about the students 

.:. Web site should contain the information about the staff of the school 

.:. Web site should contain the inform ati on about the developme nt of the 
school and the staff. 

.:. Web site sho uld conta in the Feedback form 
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3.4 Developing Des ign Strategy 

The strategy in designing the web sit e \\'ill be to explore the places of 
interest with context of tile institution . 

3.5 Designing the Web site 

After determination of the des ign issues, there is a need to dl'aw the 
logical layout of the Web site to serve the user and guide the webmaster 
for future enhancement. Chapter # 6 is dedicated for this purpose. 

3.6 Data collection 

After designing the layout of the Web site there is a need to collect 
information . The right recipes for to fill the layout of the Web site are 
in the form of text and graphics. 

3.7 Understanding the HTML and Java 

HTML and Java is the glue binding the hunk of computers with 
different architectures on the Internet. There is a need to understand 
these tools in order to communicate to the Internet. Chapter # 5 is 
dedicating for this purpose. 

3.8 Knowing the Technical stuff 

The stuff that would help to make a sizzling web site is follows . 

A sizzling site will generall y have to be accessible and attractive in 
different brO\vsers, specificall y Netscape 3.0 and Internet Explorer 3.0. 
The browser issue is becomin g increas in gly less of a focu s as hom e 
computers , and the software that people Li se , 



become more advanced. My current inclin(ltion is to .be Illll ch less 
concerned with the cross-browser iss ll e with the one exception that 
informational sites llluSt be text -access ible . 
Sites that sizzle must load within a reason(lbl e amount of time, and 
graphics should be optimized for speed but not (It loss or visual quality. 
HTML code should be clean. In many instances of sites that are well 
desi gned graphicall y, the tecl)llology is poor or vice versa . There are 
many instances in this book where this is true, but ill each case there is 
something of importance ill what that site is givin g the Web. 

3.9 Deciding the Right Tools 

Selection of appropriate hardware and software is one of the most 
important steps involved in the system development life cycle. 

3.9.1 For Developing Web Site Hardware Selection 

.:. Intel 200 MMx technology 

.:. 2.5 GB hard disk 

.:. 32xCD-Rom drive 

.:. ].44" Floppy disk drive 

.:. Color VGA monitor 

.:. Fax modem 

3.9.1.1 Scanner 
Original photograph are scanned and saved as image files, for 
displaying on screen. A scamier converts the analog information of a 
photograph into digital form for computer interpretation . Scanners are 
of various types. In thi s project flat bed scanner is used for acquiring 
photographs ofi Il sti tuti on. 
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3.9.2 Opel~ating s),stenl used in Developnlent 

The important features provided by Window 98 are: 
Window 98 de li vers the most re\vardin g Web experi ence by combining 
the power of the computer with the interactive content of the Internet : 
• Auto complete, which automatically complete previollsly visited 
Web, addresses as you type them. 

• Improved li sting of favorite Web sites. 
• Improved hi story and tracking of Web sites visited. 
• SuppOli for all major I nternet standards, including ActiveX, flash and 

more. 
• Improved performance with D ynamic HTML, which makes Web pages 

richer and more interesting. 
Multiple display support makes it possible for you to use several 

monitors simultaneously to increase the size of our desktop, run 
different program s on separate monitors, and run programs. 
Anew the computer more responsive by improving stmiup time. Using 
power management techniques, On Now can stali our computer in just 
a few seconds and restore all yo ur prohTrams where you left them . In 
addition, it allows your computer to contin,ue working even though it 
appears to be turned off You can leave all our programs running 
download our favorite Web pages, send and receive e-mail , back up our 
hard disk , or tune-up our operating system without being at our 
computer. 

3.9.3Hardware for running the Web site 

Since the window NT server will be hosting the developed Web site, 
the hardware requirements for the Web Server are as follO\vs : 

• Central Process in g UniqCPU) 

For bett er performance 23 3 MHz Pentiull1 based machine wi ll be lI sed . 
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The minimum Intel System support ed in an 80486 processor rUllning. at 
33 MH z: NT Server no long.c r support s th e Intel 80386. 

• . Random Access Memory (RAM) 

According to Microsoft, the 111 inimum amount or RAM required on the 
Intel platform is 12 M8, and on other system at least 16MB is 
required, 32 MB will be used to st3l1 with and increased as the site 
attracts more visitors. 

• Internal Bus 

The system running NT should have one of the advanced 32-bit buses: 
EISA.PCI and Micro channe l are all good choices. PCI will be used for 
this System. 

• Video 

Among the various types of monitors availabl e VGA (Video Graphic 
Adapter) can support up to 256 colors and SVGA (Super Video 
Graphic Adapter) can display images in hi gh color (16-bit). SVGA card 
will be used to view quality images. 

• CD-ROM (Compact disk-Read Only Memory) 

CD-ROM with NT server is required as no one loads large software 
Packages form floppy disks any more. In fact , server software is not 
available 011 floppy di sks-onl y on CD-ROM . 

• Mice & Serial Port 

Three Seri al ports are req uired on the server one for the mouse, one to 
attach to the U N-i nterrupted power supply and one for the modem to 
support Rcmote Access Serviccs. 



• Modems 

A modem will be requireci so that the remote users can access the 
server. Variolls mode ls or modems are ava il abl e includin g V.3 :? , VA:? 
or v.34 with varying bandwidths. Makin g a ri ght choice depends on the 
amollnt of traffi c that the Web site is receiving. 

• Communications Equipment 

Appropriate communications equipment is also required to suppOli the 
type of Internet connection chosen. The bandwidth of the 
communication circuit determines the capacity of Web server. 
Bandwidth is expressed in terms of megabits per seconds (MBPS) and 
determines how many simultaneolls users Web server can process at 
one time. The hi gher the bandwidth, the more user server will be able 
to suppOli . 

3.9.4Application Developnlents Tools 

Development of Web si te requires interaction with different software. 
Some of the software llsed in thi s project are 

• Adobe PhotoShop 

This Software is used to store pictures and images in different fil e 
format. It can edit and modify images, changes their co lors and can 
merge more than one images. It also helps in acquiring scanned images. 
Adobe PhotoShop is used in thi s proj ect to design graphics for the Web 
site. 

• Microsoft Frontpage98 

Frontpage98 Ilds Illany features to des ign and build a great looking, 
easy to nav igate World Wide Web sit e. It has two major components. 



• FrontPage Explorer, where entire Web sit e can be created , dcsi~ncd and 
managed. 

• FrontPage Editor, where Web page can be created Hypel1 ext Markup 
Language. 
FrontPage Editor is used to create, design , and edit World 'Nide Web 
pages. When text, images, tables, from fields , and other elements are 
added to the pages, the FrontPage Editor di splays them, as they would 
appear in a Web browser. 
Although it is a powerful tool , the FrontPage Editor is easy to lise 
because of its familiar, word-processor interface. Editor creates all the 
HTML code for you. 
Powerful functionality can be added to the pages by inselting 
FrontPage components. They add interactive features such as 
navigation bars, threaded discussion groups, full-text searches, and 
form handlers that would otherwise require complex programming. For 
example, the Table of Contents component automatically creates an 
HTML outline of FrontPage web with hyperlinks to each page, and the 
Banner Ad Manager replays a sequence of images using effects similar 
to a rotatin g billboard. 
ActiveX Controls, plug-ins, and flash applets in the FrontPage Editor 
can be inserted . A script-editing session can be launched and create and 
insert FlashScript scripts and Microsoft Visual Basic Scripting Edition 
scripts. 

Lean1ing the Application Deve1opn1ent Tools 

The strategy about learning the tools will be to study the documentation 
and implementing the basic features of the tools in parallel. This will 
add gradual appealin g and attractive look to the Web site. 

3.10 Development 

Deve lopmellt phase orthe Web site will be carried out paral.lel while 
learning the application development tool until a stage \vill co me that 
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the tool \vill be mastered and the refin ement orthe des igll \\"ill be 
lefto ver. 
3. 1 I Testing and Itnplementation 

Chapter # 7 is dedicated for this purpose. 
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CHAPTER · 4 

4.1 Explaining the Internet Organisln 

I 

As a person who is interested in setting lip an Internet site, one can 
think of the Internet as being the capillaries, ve ins, and arteries that 
transp0l1 data- the lifeblood of this organization- to and fonn site 
developers and Internet surfers. The next step is to Connected to he 
veins and al1eries that make up the Internet are specialized Internet 
software products. These products come in two flavors : server and 
client packages . . 

4.1.1 The Internet Server Software 
The server software on the Intemet does just what the name implies 

serves or gives out information to those who request it . This 
information may be in the fOl:m of Web pages, mail, file-transfer 
procedures, or any number of things. Server software plays a critical 
role in setting up an Internet site. Because one use this software to 
deliver the information to the surfer, understanding server systems is 
important to you as a site developer. The next step in the anatomy is 
Internet access provider. 
The Internet provider is the way to plug in to the veins and m1eries of 
the Internet. An access provider usuall y is a b,'TOUP that has rented 
access to the lnternet and then turns around and leases its rented 
bandwidth to individuals and businesses. 
Computer holding the Web site runs server software that provides 
information on the Internet. Peop le who contact yo ur site Li se client 
software to access yo ur information . TCP/ I P provides a common 
langua ge, or protocol , spoken by both server and client programs. 



4.1.2 Universal Resource Locator (URL) 

One can ' t go on the Internet without knowing what a URL is. URL 
stands for Universal Resource Locator. 
The URL is the key to uniquely identifying \he Web site and the 
information stored there. The ORL is much more than just a name, 
though . Simply giving each resource on the Internet a name isn ' t good 
enough, because names are not ahvays unique . 
For Net surfers, URLs may seem to have little reasoning behind them . 
But for site developer, understanding the makeup of URL is critical. 
Each bit of information on the Internet is known as a resource, and 
resources are stored in many formats . Some of the information is stored 
in files used on the World Wide Web, called HTML files. Other 
information is stored in documents on special servers such as Gopher or 
FTP. The list of file types and how they are served over the Internet is 
endless. 
Files that contain information are not only type of resource on the 
Internet. Resources also include interactive · programs, searchable 
databases, games, and other type of software. 
Each resource is given a URL, which specifies the following; 

• The type of resource (the protocol and server used to provide it) 

• The computer on which the resource is located 

• The name of the resource 

By using a resource ' s type , location , and name developers can build a 
unique address for every resources on the Internet . 
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4.1.2.1 UsinQ the URL to Identify Resources 

URLs identify resources on the World Wide Web. One can see them all 
over the place, on billboards and in newspaper ads and magazines. 
More than simply identifying Web resources, URLs have become the 
short hand way to identify almost every bit of information on the 
Internet . 

As Web site developer information provider, must understand the 
different palis of a URL, if you don ' t already. The first patiof a URL 
describes the type of sever software used to handle this resource. One 
can access Web pages, FTP sites and Gopher servers, for example. For 
each resource, the URL begins with an abbreviation or word that 
describes the type of server. Following are a few of them . 

http : II World Wide Web 
ftp: II FIP 
gopher: II Gopher 
news: II Usenet news 

The next pati of URL includes a very important pali of the addressing 
scheme: the name of computer ( domain name) holds Web site, where 
resource is located. One may have to ask its Internet service provider 
for this information if you are using a special Internet information 
publishing service . 
The domain name typically is followed by a forward slash (I). After thi s 
slash come the specific directories and subdirectories where the 
individual files that makeup the URL resource are located . 

To clarify the structure of a URL, look at the address 
http ://pkl.pk .colll /perf/ , which is the address of the Planetary Coral 
Reef Foundation. The SClcNCE.ORG computer as a directory named 
pe RF, containing information about the 

Planetary Coral Ree l' FOllndat ion . 



The address tell s that the site named in the URL is a Web resource 
signifi ed by http: //. The domainnam e is pkl.pk.colll. Thc subdirectory 
on the Web server that houses the information is peRF. 

4.1.3 Don1ain Nanles and IP Addresses 

The section on URLs rushed past domain names. Now one needs to 
focus on what a domain name is and why it's important for the Web 
site developer. 
Internet uses a special address, called an IP address , to identify every 
computer on the network. Local area networks can be connected to 
Internet; the word Internet actually means between networks. Each 
network that is connected to the Internet is refened to as a domain, and 
each domain has a name. In many cases, a single computer connected 
to the }nte11let as a domain name. While the access provider provides an 
Internet account we use their domain name. A domain can be a single 
computer or a network computer, which is like same "} live at 1515 
Elm Street". This address could be a private house or a huge apartment 
complex. The Web server is the server for several personal computers. 
It acts like a mailman, delivering the ri ght information packets to the 
conect machines . 
An TP address (or IP number) identifies each computer on the network, 
which is a little like a phone number. An IP address looks like this . 
Each number of the dotted quad contains significant information about 
where a computer on a network is located. 
IP numbers are not user friendly. An easier way to refelTing to the 
computers without having to memorize meaning less numbers is to give 
a computer a name. If the computer is on network, each computer on 
that network can have a name. The indi vidual computer ' s name, added 
to the domain name, 



4. 1.4 Server prO Q:ranlS 

User is connected at most with server so ftware. \Vh ich serves th e 
inform ati on on the Int ernet. Each type or Internet service has a server 
program . Some of the standard server programs are, 

• HTTP server to provide World Wide W eb pages 
• FTP to provide fil e transfer services 
• E-mail to provide Electroni c ma il to the users on the Internet 
• Gopher to provide text-based information 
• News to provide Usenet news groups 

Developers currently are working on server programs that go far 
beyond the capabilities of these servers. The new pro!:,Trams will enable 
multimedia contents to be served new and easier kind of file transfer. 

4.2 The World of World Wide Web 

World Wide W eb is a global , interacti ve, dynamic," cross-platform , 
di stributed, graphical hypeliext information system that runs over th e 
lnternet. The World Wide W eb is vast collection of information that is 
spread across hundreds of thousand of computers around the world . 
One of the best p31is of the W eb is its ability to display both text and 
graphics in full color on the same page. Before the Web, us ing the 
Internet involved simple text-only connections . 
The Web provides capabilities for graphics, sound, and video to be 
incorporated with the text, and newer software includes even more 
capabiliti es for multimedi a and embedded applications . More 
importantly, the interface to all thi s is easil y navigable-just jump from 
link , to link, from page to page, across sites and servers. 

When o ne is connected to the Web, one has equal access to 
inform ati on. 



4.2.1 Web Pa£cs 

As more and more computers using different operating systems were 
connected, the need far a cOlllmon cOlllmunications protocol became 
imperative . Eventually, a communication protocol called TCPIIP 
(Transmission Control protocol / I nternet protocol) was developed and 

I in 1983 , it became the standard communication protocol on the 
Internet. 

World Wide Web consists of two separate but closely related p3l1s; 

• Hypel1ext Transfer Makeup Language (HTML) for formatting the 
documents . 

• Hypel1ext Transfer Protocol (HTTP) for transmitting the documents 
from one computer to another. 

The web consists of a vast, worldwide collection of documents, usually 
called web page or pages for short. Each page may contain links 
(pointers) to other, related pages, anywhere in the world 

4.2.2 Web Browser 

A Web browser is the program that is used to view pages on and 
navigates the World Wide Web. Web browsers are sometimes referred 
to as Web clients or other fancy names ("Internet navigation tools"), 
but Web browser is the most common term . 

A wide array of Web browsers is available for just about 
every platform, including f:,Traphical-user-interface-based system, and 
text-only for dial-up UNIX connections. 

Most browsers are freeware or shareware or have a lenient 
licensin g policy. 

Underl inin g, displaying them in a special color, or both , 
highli ghts strin gs of text that are links to other pages, called 
hyperlinks" either. Hyperlink is a link from one docum ent to another or 
from a tex t anchor to a named location. 



The · World Wide Web is a simply deceptive mechanism. 
The \veb is simpler than a computer and a computer is a just electron 
nowing into a hunk of mat erial that manipulatcs thcm to perform 
calculations . The World \Vide Web seems to be much more 
complicated than the simple computer because or the wonderful things 
it does. The World Wide Web is based on a communication protocol. 
ThIS protocol is called' Hyper Text Transfer Protocol ' . /A protocol is a 
set of command sends by a client program to a server program. HTTP 
is the set of commands that a World Wide Web client uses to make 
request of a World Wide Web server program . The most common type 
of client program ' is World Wide Web browser' . 

4.2.3 The Protocol Which Web Accepts 

The most important thing to know about World Wide Web is the fact 
that they are well versed in many protocols, not just HTTP. To display 
text and graphics, a web browser contacts an HTTP server and has an 
HTTP conversation . However the web browsers don ' t contact an HTTP 
server instead, the browsers ' uses file transfer protocol to contact an 
FTP server. This fact is surpri sing. If the World Wide Web is based on 
the protocol HTTP, how do other protocols, such as FTP, fit into the 
picture? 

4.2.4 How the web works 

The World Wide Web is an idea within a concept, within a language 
. within a standard. The idea is that every Intelllet resource of every kind 
should have a simple, consistent address structure, called a uniform 
resource locator. 

Further the idea includes the goa l that everyone of these resources 
should be accessible from a single easy to usc, familiar interface. The 
World Wiele Web browser acts as thi s interface . The concept is c,llicel 
hypertext-text with links. The hypertext concept has been around ror 



ages. Ever since the first person dec ided to pl ace a reference to (lIlother 
work within hi s or her O\\·n creat ion peopl e have been placi ng 
references to other writin gs within their O\\·n. 
\Vhat makes hypertext in the World \Vide \Veb di fferent from simpl e 
cross-reference is that hypertext , instead of simply referring to another 
docum ent you can actuall y create a link to it. Also links to images , 
sounds, movies, searchable database, and FTP servers anything at a ll 
can be created. Because URL syntax is used to create the link, a World 
Wide \Veb hype11ext link can point to any Internet resource of any 
kind . The term hypermedia sometime is used to refer to the di verse 
resources that are linked via World Wide Web hype11exf, which allows 
user to access many forms of media beyond simple text. 
The language is called hypertext markup language. HTML is special 
text formatting language that World Wide Web browsers read to 
di splay a document, along with its links to others . Internet resources. 
Creating HTML document is the key to joining the World Wide Web. 
The standard is hype11ext transfer protocol. HTTP enables a World 
Wide Web browser or other HTTP client program to retri eve HTML 
document from an HTTP server. 
Any image sounds, or other fi les associated with an HTML document 
also can retrieve through HTTP. Software was created that combine the 
URL idea with the hype11ext concept, the html language, and http 
standard . 

4. 2.5 Settin g of a World Wide Web home page 

The thin gs are needed to setup a World Wide V/eb home page: 
• At least one htm l document to publi sh 
• A World Wide Web server th ro ugh whi ch to publish the html document 

and other fi les . 
• HTTP server can be install ed on the personal comput er. Unlink settin g 

Li p an FTP server. there is no ob·vioLi s 8c1va ntage to se tti ng li p the OV,,' 11 

IITT P server on the personal computer, (lside from the f~lct that to avo id 
pay in g fee s to a World \Vide Web service provider. Even thi s 
~lc1va n 1c l ge Illay be off set ; however, by t·he cost c.Iec.l ica ted In ternet 
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connecti on that is necessary lo r IITTP ser\ 'er to be access ibl c to other 
lI scrs at all timcs. 
The deve loper has to keep in mind that the \\'orld wide wcb is cvolvin g 
r<1p idly. standard are chan gcd and ne\\' technology is being created all 
the time. Most World Wide \.\t'eb ~e rv i ~e providers charged by the 
number of bytes that you publish by the amount or network traffic that 
yo ur publi shing generates . More people reading yo ur World Wide Web 
mean more work tor yo ur service provid.er, so it passes 011 the cost to 
YOll . 

\Vhenever an http server is setup to a publishing service at least one­
html document to publi sh on the World Wide Web is needed. 

4.2.6 Using a Service Provider for World Wide Web 

It is possible to subscribe to web publishing service, which means that 
web pages will reside on someone, else computer. That is attached to 
the Internet full time and runs the server program. The anangements 
mean that the documents are visibl e and available through the web all 
the time . Service provider should give at least two things 

• A user-id and password 
• A directory so that it will available on the web . 

4.2.7 Understanding ho\v FTP works 

By setting Lip the FTP server fil es can be sent to and received from the 
Internet. Any onc v"ho uses World W ide Web browser can access fil es 
on FTP server. FTP is a protocol that all ows computer to transfer the 
data over the I nternet. An FTP cl ient program sends a request to an 
FTP serve r asking tu exchange in/ormation and tra nsfer ril es . The 
scrver then vc rifi cs that the LiseI' is authori zed to send or rece ive filc alld 
responds to the requcst acco rdi ngly. Vv'or ld \V idc ' We b browse r 
support s the part of FT P 1'h ('l t enables to be retrieved, b~l t not send . FTP 
maint ai ns th c ori ginal IOl'm <l ttin g ofth c file s. 



4.2.8 Us in ,Q the FTP cli ent 

Numerous hl"raphi ca l FTP c li ent so ftware packages are ava ilable as 
freeware or shareware, One o f the best FTr c li ent s ava il abl e on th e 
Internet is W S FTP , 

4.2.9 Providing fil es by using FTP 

The potentials of FTP are limitless. Some companies use an FTP server 
to provide remote sites. 
Customer support ; other companies use FTP for communication w ith 
employees at 

Providing fil es could fulfill numerous needs by FTP to the general 
publi c or specific people . The answer is simple: FTP setup on the 
Internet was establi shed more than 25 years ago to meet the research 
needs of the US defense industry, but it has grow into a huge globa l ' 
network serving uni versiti es, academic research, Government agencies 
and commercial interests, both in the United States and in more than 
100 other countr ies , 
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Chapter 5 HTML 

5.1 Html 

HTML is a standard generalized Mark Language (SGML). Document 
Type Definition (DTD). An SGML document has three parts .The first 
part defines the character set to be used and tells which character in that 
set distinguish text from markup tags . Markup tags specify how the 
viewer application, or browser, should present the text to the user. The 
second part of an SGML document specifies the document type and 
states which markup tags are legal. The third part of an SGML 
document, called the document instance, contains the actual text and 
markup tags . Because there is no requirement that the three parts of an 
SGML document reside in the same physical file , we can concentrate 
on the document instance. The web pages you create are document 
instance. 

Without HTML, the World Wide Web wouldn' t, exist. HTML allows 
the individual elements on the web to . be brought together and 
presented as a collection. Text images, multimedia, and other fi les can 
all be brought together use HTML. Fonns are used to elicit responses 
from users through a bTfaphical user interface consisting of fill-in 
blanks, buttons, check boxes, and other features. After the user fills in 
form values, a script or executable program can lise the entries. Forms 
provide the inclusion of objects like text boxes, choice lists, and have 
proved invaluable for recent HTML applications-particularly, search 
engines, database query entry , and so on . These HTML elements can be 
used to easily define the presentation of the form to the lIser, the real 
value behind any form is in what it dose with the information that IS 
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entered . For a form to do anything more than send a straight text dump 
of the form data to an E-mail address, the form data will need to be 
passed to some kind of CGI SCRIPT or server-based executable for 

processll1g. 

Forms can contain text-entry areas, radio buttOlis, or simple menus of 
items. When the fOl1n is '"submitted", the information you typed is sent 
back to server where the pages originated. The FORM element defines 
a block of input field that user may fill in. The browser usually sends 
the user ' s data to a CGI application on the server. Data is sent as 
name=value pairs separated by ampersands (&). THE, name=value 
pairs are URL-encoded-spaces are converted to pluses (+) and soine 
characters are converted to a percent (0/0) character followed by the 
character's two digit hexadecimal value . 

5.1.2 Tables 

Tables are used to organize and present infonnation in rows and 
columns. Tables are very flexible way to line lip items according to a 
grid pattern. A grid pattern can be a very effective way to provide 
visual cohesion on web page. The element TABLE is used to define 
tables. With in the table element, we the TR element for table rows, TH 
for table header, TD for table data, and the caption element for the table 
caption. 

Internet Explorer supports the placement of the <TABLE> element. 
The image is tiled behind all the table cells. Any ·of the supported 
graphics file formats can be llsed as a graphic behind a table. 

5.1.3 Frames 

FRAME gives us a unique way to organize and structure our HTML, 
document, letting liS create compound documents that the user can 
divide a browser window into di fferenl pans of information that can be 
viewed and changed independently. 



By dividing the main window we can display a separate document into 
a set of frames . Currently, only Netscape and Microsoft Internet 
Explorer browser recognize frames. The new elements to implement 
the frames are FRAMESET, FRAME and NOFRAMES. The 
FRAMESET element is the container for a frame, instead of BODY 
element, a frame document uses FRAMESET. 

Frame has six attributes: 

• MARGINHEIGHT= number 
The valve specifies the top and bottom margin of the frame. 

• MARGINWIDTH = number 
The value specifies the size of the left and right margin of the frame. 

• NAME = string. 
The value is assigned to its frame so that the frame can be targeted by 
other links. ' 

• NORSIZE. 
This attribute prevents the user from being able to resize this frame. 

• SCROLLING = string. 
The value indicates how 'scrol1 bars sho uld be used with the frame. 

• SRC = string. 
The value specifies the URL for the document to be located into the 
frame. 

5. 1 .4 Multimedia 

The basis for Illllch of the technical specification for multimedia used 
with Web browsers and helper application is Multipurpose lnternet 
Mail Extensions (MIME) . MIME is A specification for how the 
computer system c·an exchange multimedia information lIsing Internet 
mail standards. MIM E includes specificat ion for non-ASCTI character 
sets, images, movies, binary fli es, postscripts and other multimedia and 
binary fil e format s. In addition to suppOliing many predefined 



multimedia file types, MIM E also · allows the user to define a format 
type and exchange Information lI s ing it. Th e MIME spec ifi cation lIses a 
system of message type and sub type to identify the format of a 
message; The MIME types are image, audio, text , video, application , 
multipart, message, and extension-token (any name beginning with x­
an experimental data type) . MIME subtypes identify more specifically 
the contents of the message . The MIME type/subtype Text/html , for 
example, identifies a text file that should be interpreted as an HTML 
document. The MIME type/subtype video/ mage identifies an MPG E 
movie file. A Web server uses file extension to determine the MlME 
type and subtype for a multimedia file when it is sent in response to a 
Web browser request. 

5.1.5 IMAGES 

Images and icons are useful for adding interest to a page, both from the 
flash point of view and from the information point of view. Images can 
be very impoliant in many presentations. linages can have a very strong 
visual impact on a Web site as long as they are not overdone or poorl y 
ananged. Images playa large role in the Web, and placing images in 
Web pages and having the capacity to manipulate them with " tricks" 
can help a developer make the best use of them . Recently, the <IMG> 
element has undergone the largest enhancement of all htm} elements on 
the way to newer html standardization . This is due to the 
<IMG>element being probably the second most important markup 
element because it handles all embedded graphical content in HTML 
document. 

5.1.6 IMAGEMAPS. 

The general idea of an image map is that L1ser click on an image and, in 
response, vi ew the reso urce or download the content associated with 
the pi xe l on the image where they clicked. To ·implement thi s, 
deve loper has to create an image, prepare a li st of the correspondence 
of the pi xe l on the images to resources, and th en make these two pieces 
"active" on the web page . We enable the connection between the ima ge 



and the list of corresponding resources through the server or through 
the user ' s client 

5.1. 7 ANCHOR ELEMENT 

The anchor text is probably the single most useful HTML element. It is 
the element that is used to denote hyperlinks-the elitire essence of 
HTML as a hypertext application. 

5.1.8 Block Formatting Elements 

Block fonnatting elements are used for the formatting of text within an 
HTML document. They should all be within the body of the document 
(that is, within the <body> .. . </body> elements) . 

5.1.9 Character Data 

Within an HTML document, any characters between the HTML 
ELEMENTS REPRESENT texts . An HTML document (includin g 
elements and text) is encoded by means of a special character set 
described by the char set Parameter. Essentially, this. is restricted to a 
character set known as US-ASCII (OR -ISO-8859-1), that encoded the 
set of characters known as Latin ALPHABET Nol (commonly 
abbreviated to latin-1) . This covers the characters from most Western 
European Languages. It also covers 25 control characters, a soft hyphen 
indicator, and unassigned characters, 93 graphical characters, and 8 
unassigned characters . It should be noted that non-breaking space and 
hyphen indicator characters are not recognized and interpreted by all 
browsers : because of this, their use is discouraged . There are 58 
character positions occupied by control characters . . HTML provides 
character-entity references and numerical char(lcl er re ferences 10 
facil it at e the entry and interpretation of characters by name and by 
llum erical position . Because certain characters are interpreted as 
markllp, they must be represented by entity references. 



5.1.10 Docunlent Sound. 

Two different elements now ex ist ror employin g inlin e sound directl y 
in an HTMLdocument. The first is BGSOUND: Microsoft Internet 
Explorer and Netscape Collabra cunently supp0l1 this element . The 
other is SOUND, Which currently is suppolied only by NCSA Mosaic. 
Mosaic also supports a limited version of 'Microsoft ' s BGSOUND 
element. Netscape can support in line sound via the plug-in mechanism. 
The BGSOUND element allows you to create pages that play sound 
clips or background soundtracks while the page is being viewed. Sound 
can be samples (WA V or AU or MIDI or MID) format 

.5.1.11. List Elements. 

HTML supports several types of lists, all of which may be nested. If 
used, they should be present in the <body> of an HTML document 

5.l.12 Font Size and Color 

The fONT element defines the font size for contained text. The size 
may be absolute: the browser adds the font value to relative font size. 
To set the size and color of any text on a Web page, use the <FONT> 
tag: 

Syntax 

<fONT SIZE=5 COLOR="PURPLE"> this text will be big and purpl e. 
~FONT> ' . 

The SIZE attribute can take any value from 1 (tiny) to 7 (fa irl y big): 
with 3 bein g the normal defaults size. 

The COLOR attribute call take any of the followin g 



Stclildard color names: Black , 'vYhite, red, green , blue, aqllCl , 
Fuchsia , gray, lime, maroon, purpl e, navy, olive, silver, or 
Teal. Tags that take color attributes may speci fy the co lor 
Values in different ways: by name or by hex triplet. There 
are 140 defined color names, such as red, black, and 
turquoise . 

Font two attributes: 
.COLOR = color 

The value specifies the color for normal text within the 
FONT ELEMENT. 

• Size = string 
The value may be a number (absolute size) or a number proceeded by a 
+ or - character (relative size). 
The FONT element is a container element that may contain content text 
311d A, B, BASEFONT, BIG, BLINK, BR, CITE, CODE, EM, FONT, 
T, Uv1G , KJ3D, NOBR, SAMP, SMALL, STR1KE, STRONG, SUB, 
SUP, TT, V AR, and WBR, elements. 

5 1 1 4 T T'T'1\ .lfL 'T' -
.1.1 n11v1 lags 

These tags are used to create a basic HTML page with text, heading, 
and lists . An (MS) beside the attribute indicates that it is only sUPPOlied 
by Microsoft Intetnet Explorer. 

5.1.1 5 Objects 

Objects add functionality to our HTM..L, document by letting us to 
insert images, video and prohrrams, such as JA VA and Active X 
controls. 
To . insert an object, we use the OBJECT tag, supplying an attribute 
value that spec ifies the object~ we use the OBJECT type, locati o ll , 
initi al clata and so 011. I f the object has set able properties, we can set 
these using the PARAM tag . 
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Using the Library window 

Each Flash file has its own library that may contain symbols, bitmaps, sound, and 

video files. Use the Library window to view and organize the contents of the file's 

library. When you select an item in the Library window, Flash previews the item at 
I 

the top of the window. If the selected item is animated or is a sound file, you can use 

the controller to preview it. 

You can organize library items into folders. The Library window columns list the 

name of an item, its type, the number o[times it's used in the file , and the date on 

which is was last modified. You can sort items in the Library window by any 

column. 

To display the Library window: 

Choose Window> Library. 

To change the width of columns: 

Position the pointer between column headers and drag to resize. You carulOt change 

the order of columns. 

Q 
To resize the Library window: Do one of the followmg : 

Drag the lower right corner. 

Q 
Click the Wide State button to enlarge the Library window so that it displays all the columns. 

Q 
Click the Narrow State button to reduce the width of the Library window to the Name column 

only. 
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Using Publish Preview 

Publish Preview exports the type of file you se lect fTom the Publish Preview menu 

and opens it in the default browser. I f you preview a QuickTime movie, Publish 

Preview launches the QuickTime Movie Player. I f you preview a projector, Flash 

launches the projector. 

The Publish Preview menu displays the formats you select in the Publish Settings 

dialog box. It also export all formats using the current Publish Settings options. 

To preview a file with Publish Preview: 

1 Use Publish Settings to define export options. 

Choose File> Publish Preview and then select the file format you want to preview from the 
2 

submenu. 

Using the current Publish Settings values, Flash creates a file of the specified type in the 

same location as the Flash movie file. This file remains in this location until you overwrite or 

delete it. 

Press F12 to export and preview the default format. 
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Assigning actions to buttons 

Assign an action to an instance ofa button to have the action run when the user clicks or rolls 

over a button. Assigning an action to a button instance doesn't affect other instances of the 

button. 

When assigning an action to a button, you specify the mouse events that trigger the action. You 

can also assign a keyboard key that triggers the action. 

To assign an action to a button: 

1 Select a button instance and choose Modify > Instance, or double-click the button instance. 

2 Click the Actions tab. 

Click the + (Plus) and choose a statement from the pop-up menu. 
3 

If the Actions tab is not available, the selected instance is not a button. You can click the 

Defmition tab and make the selected instance behave as a button, but the instance probably 

will not have the special button states associated with it. See Creating buttons. 

When you choose a statement, Flash automatically inserts an On / End On statement and 

sets Release as the default button state. You can also select On MouseEvent to insert an 

On/End On statement. 

In the Parameters pane, with the On (Re l ease ) statement highlighted, select which 
4 

mouse and keyboard events trigger the action: 

Press Occurs when the mouse button is pressed while the pointer is over the button. 

Release Occurs when the mouse button is released while the pointer is over the button. This 

sets up standard clicking behavior. 

Release Outside Occurs when the mouse button is released while the pointer is outside the 

button. 

Roll Over Occurs when the pointer rolls over the button. 

Roll O ut Occurs when the pointer rolls outside the button. 

Drag Over Occurs after the mouse button has been pressed while the pointer is over the 

button, rolled outside the button, and then the pointer is rolled back over the button. 

Drag Out Occurs when the mouse button is pressed over the button and the pointer then 



rolls outside the button. 

Key Press Occurs when the specified key is pressed. 

5 Click the + (plus) and choose a statement fTom the pop-up menu. 

Depending on the action you choose, the Parameters panc can otTer additional paramcters for 

the statement. For information about a specific statement, see the topics later in this chapter. 

You can also look up specific statements in the Index. 

If you are familiar with basic programming techniques, you can enter paranleters that Flash 

can evaluate when the movie is playing. See Writing expressions. 

6 Assign any additional statements that you want. 

Flash inserts the statement below the currently selected action. Use the up and down buttons 

to change the order of statements. 

To test a button: 

Choose Control> Enable Buttons before playing the movie. 
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CHAPTER 6 User/WebInaster Guide 

6.1 Webmaster' s Guide 

The task of creating a Vv'eb site is not finished once it goes online to the 
Internet. The real work is just beginning. New material should be 
regularly added to the web site to keep it looking fresh and also to keep 
those visitors coming back time after time . The Web site administrator 
calTies out the maintenance and administration of Web site . 

A short guide is provided to help the Webmaster in carrying out his 
duties . 

6.1.1 Duties 

The important duties calTied out by t5he Vv'ebmaster will include : 
• Preparing and adding new HTML content. 
e Inspecting system logs. 
• Testing actjve links and locating new links . 
• Testing ISAPI applications . 
• Responding to feed back from users. 
• Keeping up with the latest development in Web technology . 
• Backing up the server. 
• Installing software upgrades and system patches. 
• Troubleshooting server problems . 
• Upgrading system hardware. 
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6.1.2 Guidelines 

• Window NT server 4.0 is se lected as the operating system, where as 
Internet information server is the \Veb server hosting 'T G Boys Hi gh 
School Pano Akil Cantt" Web site. The full documentation of the tow 
products are available bo/th manually and online . This documentation 
will help the Web master in managing server activities e.g. backing up , 
troubleshooting, upgrading, inspecting system logs, installing new 
software, testing ISAPI application etc. 

• Most Microsoft family products have been used in the development 
of Web site. All of them sllppOli graphical user interface and are easy 
to use. Their documentation is available in the form of manuals and 
also online. 

• Effort has to be generated in revising the contents of the Web pages, 
updating old ones, and creating new web documents . For this purpose, 
Webmaster will have to keep in touch with F G BOUS IDGH 
SCHOOL; P ANO AKIL CANTT: for getting information about the 
institution's upcoming events, and the current situation of the academil: 
developments and improvements to wards education undertaken by the 
F G Boys High School Pano Akil Cantt. Using digital Camera or 
Scanner, Webmaster has to take Photographs of ongoing activities, 
process these images 

and activities on server. 
• Microsoft Front page 98 is the tool used for Web Publishing. For 

managing links, testing activities or locating new links or, components 
of Front page Explorer can be used. 

• Webmaster must go through visitor ' s comments, complaints and 
suggestions, which they provide through feedback forms . He should 
also contact through E-mail , those visitors who are jnterested in 
knowing more about the F G Boys High School Pano Akil Cantt; and 
upcoming events by updating the NEVIS Information page. 

• Webmaster must maintain the E-mail records separately, for 
providin g the management of the associati on with necessary feed back . 
The Web site of Federal Government Boys Hi gh Schoo l Pano Akil 
Cantt ; is developed under strategy i. e. to explore different aspect of 
edul:(ltio llal system by del: iclin g the steps in the logil:a l design of the 
Web site or reJeral Governlll ent Boys High School Pano Akil Ca ntt. 
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CHAPTRE 7. Testing and inlplelnentation 

7.1 TESTING AND IMPLEMENTATION 

Testing is an important phase in the system development life 
cycle. Its importance is doubled when Web site testing is in question . A 
Web site should be thoroughly tested before it is announced on World 
Wide Web and is opened for visitors on the Internet. 

7.2 Web site Testing 

Once the Web site of Federal Government Boys High 
School Pano Akil Cantt; is dcveloped, it is tested offline at first to 
squeeze out the obvious elTors and to make sure that every thing is 
di splayed as expected and that all the internal links are operational. 
F1l11her, each Web page is separately tested on browsers namely tbe 
Internet Explorer 4.0 and Netscape Navigator Gold. The graphics 
included in the web documents are also into consideration . It is tested 
how graphics are di splayed and they look all ri ght as expected. Rest of 
the testing wi 11 be c.arried out when the 'Neb site is opened for display 
on the Internet. Then a strategy will be adopted to test the site a number 
of times during the day and night in order to see what happens as the 
network traffic changes. Also site w ill be accessed using different 
communication links, if that is possible, to gauge the difference that 
speed and bandwidth procedure. 

7.3 Q uality ,Assurance 

Ii is es timated th at a Web sIte take 5 to 6 month s before it 
beco llles rull y functiollal 011 tile Illt ertlel alld starts attractillg visitors. 
However, good des ign practice and sk ill s L1 sed in deve loping web s ite 
make all the cli fTe rence in maintenance and quality is not the case thal 
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once the \Veb sit e is designed, deve loped cl1ld tested and it ' s quality is 
gllarc1l1tced, and the n the job of the developer is fini shed. The fact i:-:; 
that a continuous eff0l1 is to be 1!.enerated in rev is in 1!. th e conte nt s oftb e 

<-- <--

web sit e . 
So that it contin ue to attract visitors. A web s ite should be we II 
managed and administered on ly then its quality can be assured . 

7.4 Publishing on the Internet 

To publi sh on the Internet, the followin g items will be required : 

• A suitable communications links to the Internet, provided by the ISP, 
Tnternet services provider. 

• The appropriate hardware and device drivers to connect the server to that 
communication circuit . 

• An IP address provided by the [SP 
A DNS-registered names for that IP address, from inter NTC. 

7.S System Evaluation 

System evaluati on determines w hether the desired objectives of the 
system have been met or not. Since no system is ever complete, or 
perfect, it w ill be updated, as changes are likely to take place. 

7.6 Merits 

T he Federa l Government Boys High School Pano Ak il Cantt ; we b sit e 
offer the foll owing merit s: 



• A truly interactive web site providing interesting information to its 
visitors about the institution, its educational planning, administration, 
achievements and development. 

• Offers a good platform to project institution 's part in promoting 
education on SSC level. 

• Offers an effective means to promulgate the constitution of the 
institution and their activities on through the web site. 

• Provides the institution data in an organized manner, which is definitely 
more effective than the current manual system. 

7.7 Demerits 

• Hungry is storage is requirement, may take up a lot of storage 
requirement, may take a lot of storage space on server's hard disk, as 
data comprises of large size graphic fi les. 

• Regular updating of data and revision of web page contents is required . 
. Resources like Scanner, digital camera etc .... are needed for getting 

latest information about the Institution. 
• During visits to the Web site, visitors may find some broken inks or 

may face some problems in viewing graphics as they are being 
downloaded on their browsers. 

7.8 Future Enhancements 

• At present, the web site caters for only one institution but in future, the 
system design can be improved further to cater for more abo ut Federal 
Government Educational Institutions (Cantt/Garrisons) allover the 
country as well. 
In short, the deve lopment of the system is just the first step to preserve 
information abo ut Federal Government Boys High School Pano Akil 
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Cantt; in an electronic form. It has a lot of potential to grow and expand 
in futme. 

APPENDIX C 

Graphic File Formats 

• Gifs 

The Graphic Interchange Format (GIF) is the most widely used image 
format on the web. GIF is a raster based, file format that supports 
transparent background and a maximum of 256 colours. Raster images 
are composed of tiny dots or pixels. Many browsers support inline GIF 
images, such as LOGOS. Browsers that do not support inline often 
support viewing ofGIF images through an external viewer. 

e JPEGs 

For including colored photographic in web documents, joint 
Photographic Experts Group (JPEG) fonnat is JPEG format is the best 
suited for" true color" images such as scanned pictures. It does not 
work as well as GIF for computer generated images with .few colors, 
JPEG is raster-based file format that · supports 16 million colors, and 
should only be used for high definition graphics, JPEG files can be 
compressed, however, compression tends to reduce image quality; 
There are some JPEG compression methods that retain more quality, 
but produce larger compressed files. JPEG image take longer to 
decompress than other compressed image format. Also, most viewers 
do not display JPEG images as they are being downloaded. 
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- Tiffs 

Tag image tile format (TIFF) is an extensible file format to format to 
store raster-based images from scanner screen captures programs, and 
photo-enhancement programs. Number TIFF extensions allow for 
greater flexibility but also make it difficult for viewers to anticipate and 
handle the varieties of TIFF format. TIFF images are not compressed 
and require more space than many other image file types . 

-BMPs 

The Bitmap (BMP) file format is another common file format to store 
raster-based images. It is a fairly simple, device independent file 
format. There are four variations of BMP files; Monochrome, 6 colors, 
16 colors and 24-bit (which contain over 16 million colors). The BMP 
file format is often used for screen captures and icons. 

-CGMs 

The computer Graphics Metafile (CGM) format is vector based, 
meaning that these images are stored as groups of complete objects, 
such as lines and circles, not as pixels. As a metafile, CGM format can 
also include raster-based information. 
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